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CALIBRATION PROCEDURE

NI PXI-665x

This document describes how to write a calibration procedure for the
10 MHz oscillator frequency of the NI PXI-6653 and NI PXI-6652 timing
and synchronization modules.

Contents

CONVENLIONS ...uvviieiiieeeiiiieeeieeeeveeestreesereeesebeeessbeessseeesseasssseseasssesssseeeas 1
SOTEWATE ..eviieiieeciie ettt e e eree e et e e er e e e eb e e e b ae e staeeessaeeesseeeanns 2
DOCUMENLALION ...ecueviieeiiieciiiee ettt see e re e ae e e re e e b e e esvaeesereeaas 2
Calibration INterval ...........cccueiiiiiieiiiieiiiecie e e 3
PaSSWOTIA .....eoiiiiii ettt e et e ear e earee s 3
Test EQUIPIMENLE ...cc.viiiiiiiieiiieieeete ettt s e 3
TeSt CONAILIONS ..veeiviieeiiieeiieeeieee et ee it eeebe e e e e esaeeesreeeeseeeesssesessneeas 3
Calibration Procedure .............cccueeeuviieeiiieiiie e eeeeeeeree e 4
TNAtiAl SELUP ...eiviiiiiiiiie e e 4
VETfiCAtION .....viiiiiieeciie ettt e tae e tae e enteeeenes 4
Connecting the Clock SOUICE ........cocuvevieriiriiienieereeneeieeeen 4
Measuring the Frequency .........ccccveeeveeniiiniieenienneesieeieeeeen 6
AJUSTMENL ...covviiiieiiiiiie ettt sae e st s 10
ReVerifiCatioN........ceeiiiiieiie ettt et eee e 13
Where to GO fOr SUPPOTL.......ooviiriiiiiiiieeiie sttt 14

Conventions

The following conventions apply to this document:

» The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a note, which alerts you to important information.

é When symbol is marked on a product, it denotes a warning advising you to
take precautions to avoid electrical shock.
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bold

italic

monospace

Software

When symbol is marked on a product, it denotes a component that may be
hot. Touching this component may result in bodily injury.

Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names.

Italic text denotes variables, emphasis, a cross-reference, or an introduction
to a key concept. Italic text also denotes text that is a placeholder for a word
or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.

This calibration procedure requires NI-Sync and NI-VISA. NI-Sync and
NI-VISA support a number of application development environments
(ADESs) and programming languages, including LabVIEW,
LabWindows™/CVI™, and Microsoft Visual C++. When you install the
drivers, you need to install support for only the ADE or programming
language you are using. The illustrations in this document show the
LabVIEW code for implementing calibration steps using NI-Sync and
NI-VISA.

Documentation

You need the NI-Sync User Manual to calibrate the NI PXI-665x.

The NI-Sync User Manual contains detailed information about using

the NI-Sync driver, including information about installing NI-Sync and
creating applications that use the NI-Sync driver. These sources, along with
this document, are your primary references for writing your calibration
utility. You also can refer to the documentation for the programming
language or application development environment you are using. For
further information about the device you are calibrating, refer to the

NI PXI-665x User Manual.
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Calibration Interval

The measurement requirements of the application determine how often you
should calibrate the device to ensure its accuracy. National Instruments
recommends that you calibrate the NI PXI-6653 and NI PXI-6652 yearly.
You may want to shorten this interval based on the application demands.

Password

The default password for password-protected operations is NI.

Test Equipment

Calibrating the NI PXI-665x requires the following equipment.

Equipment

Recommended Model Requirements

10 MHz clock source

Symmetricom/Datum 8040 Accurate to within

0.75 parts-per-billion (ppb) for the
NI PXI-6653, or 150 ppb for the
NI PXI-6652.

BNC-SMB cable

SMB-SMB cable

Test Conditions

Follow these guidelines to optimize connections and test conditions during
the calibration procedure:

© National Instruments Corporation

Install the NI PXI-665x in Slot 2 of the PXI chassis. The calibration
procedure requires features of PXI that are accessible only in slot 2.
Use of an NI PXI-1044 or NI PXI-1045 chassis is recommended to
reduce error associated in variance in the 5 V chassis supply.

Maintain a temperature of approximately 25 °C.
Keep relative humidity below 80 percent.
Use shielded copper wire for all cable connections to the device.

Allow a warm up time of at least 15 minutes for the NI PXI-6652 and
three hours for the NI PXI-6653 to ensure the measurement circuitry is
at a stable operating temperature.

Keep PXI chassis filters clean and fan speed set to High.
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Calibration Procedure

The steps used in the calibration procedure are as follows:
1. Initial setup.
2. Verification.
3. Adjustment.
4

Reverification.

Initial Setup

Complete the following steps to set up the NI PXI-665x for calibration.

1. Make sure all components involved in the calibration procedure are
powered off.

2. Install the NI PXI-665x board into slot 2 of your chassis.
@ Note The module must be installed in slot 2 of the chassis.

Power on the PXI chassis first, and then the external equipment.

4. Make sure that all the appropriate driver and application software is
installed on the host computer.

5. Configure the hardware properly with Measurement & Automation
Explorer (MAX). Refer to the NI PXI-665x Installation Guide for
details about configuring the PXI equipment.

Verification

The following steps outline the procedure for measuring the 10 MHz
oscillator frequency on the NI PXI-665x and determining whether the
device requires adjustment to meet the published specifications.

Connecting the Clock Source

1. Connect the accurate 10 MHz source to the ClkIn connector on the
NI PXI-665x.

2. Program the NI PXI-665x to route the ClkIn signal to PXI_Clk10In
without using its 10 MHz PLL by completing steps a—d.

@ Note Use the data in the C function call reference as inputs to your LabVIEW VI where
applicable.
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a. Call niSync Initialize VI to set up a handle for the device.

LabVIEW Block Diagram NI-SYNC C Function Call

Call niSync_init with the following
parameters:

nigync [nitialize. wi

[E20UICE Name

@P“‘;

instrument bandle oub

resourceName: Dev1l
"""""""" : idQuery: NULL

: resetDevice: VI_TRUE

rezet device

vi: *SessionHandle

b. Set a writable NI-Sync property node to pass FALSE to the
Use PLL? attribute.

LabVIEW Block Diagram NI-SYNC C Function Call

Call nisync_SetAttributevViBoolean
with the following parameters:

rnce i reference oul
vi: “<SessionHandle> "
[Property Nade] I terminalName: *~
m ﬁ =z niSync !,h! attributelD:
L= P UsePLL? NISYNC_ATTR_CLKIN_USE_PLL
attributeValue: VI_FALSE
=1

c. Call niSync Connect Clock Terminals VI to connect ClkIn to
PXI_CIk10_In.

LabVIEW Block Diagram NI-SYNC C Function Call

Call niSync_ConnectClkTerminals
riSync Connect Clock T eminals. vil with the following parameters:

instrument handle in

zource terminal
Clkin =

destination kerminal

: vi: “<SessionHandle>~

inztrurent handle out .

sourceTerminal: NISYNC_VAL_CLKIN
destinationTerminal:
NISYNC_VAL_CLK10

efror in (o eror
[E=ik koo pPa & |
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d. Call niSync Close VI to close the handle.

LabVIEW Block Diagram NI-SYNC C Function Call

Call nisync_close with the following
inztrument handle in| parameter:

vi: “<SessionHandle> "~

S d i lemar oul
el i [ho ermor bl pmz s ]

Measuring the Frequency

Complete the following procedure to measure the frequency of the onboard
clock source.

1. Connect the ClkOut terminal to the PFI O terminal by using an
SMB-to-SMB cable.

2. Complete steps a—d to program the board to connect the onboard
oscillator to ClkOut. Be sure to use the high-gain setting for clock out.

a. Call niSync Initialize VI to set up a handle for the device.

LabVIEW Block Diagram NI-SYNC C Function Call
Call niSync_init with the following
resourcs hame [ _ |instrument handle out parameters:
Libct—y

resourceName: Devl
"""""""" : idQuery: NULL (ignored)

1l resetDevice: VI_FALSE

rezet device

vi: *SessionHandle

b. Setawritable NI-Sync property node to pass TRUE to the ClkOut
Gain Enable attribute.

LabVIEW Block Diagram NI-SYNC C Function Call
Call niSync_SetAttributeViBoolean
EE——) with the following parameters:
. .
_J— vi: “<SessionHandle> "
Froperty Mode . R

o 1 g — tern'nnalName.

[(Sack oW CIkOut Gain Enable attributelD:
NI S.YNC_ATTR_CLKOUT_GAIN_ENABLE

i — = attributeValue: vI_TRUE

Clk Properties: ClkOut Gain Enabls]

NI PXI-665x Calibration Procedure 6 ni.com



c. Call niSync Connect Clock Terminals VI to connect the oscillator

to CIkOut.
LabVIEW Block Diagram NI-SYNC C Function Call
Call ni Sync_ConnectClkTerminals
instrument handle in ni Conrect Clock T erminalz. vil with the following parameters:

ibstrument handle ool VL. “<Sess1or.1Handle> !
sourceTerminal:
NISYNC_VAL_OSCILLATOR
destinationTerminal:

source terminal

Oscillatar |

destination terminal

ClkQut - NISYNC_VAL_CLKOUT
error in [no error
[Ssuk e | 5|

d. Call niSync Close VI to close the session handle.

LabVIEW Block Diagram NI-SYNC C Function Call

Call niSync_close with the following
parameter:

instrument handle in

niSync Cloze. vi
-SYHE

vi: “<SessionHandle>~

(oot et :
errar in [na errar b B 55 |
3. Complete steps a—c to measure the oscillator frequency through PFI 0.
To obtain an accurate measurement for calibration, the measurement
duration must be made sufficiently long. Refer to Table 1 for the
measurement duration to use.
Table 1. Measurement Duration
Required Measurement
Device Measure Accuracy Duration
NI PXI-6652 200 ppb 0.5 seconds
NI PXI-6653 1 ppb 100 seconds
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a. Call niSync Initialize VI to set up a handle for the device.

LabVIEW Block Diagram NI-SYNC C Function Call
Call niSync_init with the following
esource name [ instrument handle out parameters:

B error ault]
rezet device

E..... |

resourceName: Devl
idQuery: NULL
resetDevice: VI_FALSE
vi: *SessionHandle

b. Call niSync Measure Frequency VI to measure the frequency of

the oscillator.

LabVIEW Block Diagram

NI-SYNC C Function Call

niSync Measure Frequency. wi
HI-SYHE

instrumeant bandle out

E

ibstrument handley

Call niSync_MeasureFrequency with
the following parameters:

vi: “<SessionHandle> "
sourceTerminal:
NISYNC_VAL_OSCILLATOR
duration: 0.5 or 100

-
3 actualDuration: *actualDuration
: measuredFrequency:
@ (orrar o] *measuredFrequency
[T o s | = error. *error
c. Call niSync Close VI to close the session handle.
LabVIEW Block Diagram NI-SYNC C Function Call
Call niSync_close with the following
inztrurent handle in parameter:
(BT -
vi: “<SessionHandle>"
o — ;
error in [ho eror e |

NI PXI-665x Calibration Procedure
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To determine if the device under test meets its specifications, you must
compare the measured frequency obtained in step 3 of Measuring the
Frequency with the specified accuracy. Table 2 shows the frequency range
that is acceptable according to the published specifications for the

NI PXI-665x.

Table 2. One Year Test Limits

Specified Acceptable Frequency Range—As Found
Accuracy +
Device Aging Low Limit High Limit
NI PXI-6652 + 3.5 ppm 9,999,965 Hz 10,000,035 Hz
(TCXO)
NI PXI-6653 + 57.6 ppb 9,999,999.424 Hz 10,000,000.576 Hz
(0CXO0)
Table 3. 24 Hour Test Limits
Specified Initial Acceptable Frequency Range—As Left
Device Accuracy Low Limit High Limit
NI PX1-6652 + 2.5 ppm 9,999,975 Hz 10,000,025 Hz
(TCXO0)
NI PXI-6653 + 6.1 ppb 9,999,999.939 Hz 10,000,000.061 Hz
(0CXO0)
If the measured value is within the low-limit and high-limit range listed
under the Acceptable Frequency Range—As Left in Table 3, the board is
meeting published specifications for the 24 hour period following a
calibration.
Table 4. Calibration Target Frequency Ranges
. . Calibration Measurement Target
Calibration
Frequency Range
Measurement
Device Accuracy Low Limit High Limit
NI PX1-6652 200 ppb 9,999,998 Hz 10,000,002 Hz
(TCXO)
NI PXI-6653 1 ppb 9,999,999.99 Hz 10,000,000.01 Hz
(0CXO0)
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If the measured value is within the low-limit and high-limit range listed
under the Calibration Measurement Target Frequency Range in Table 4,
the board is considered to be calibrated and no adjustment is needed.

Adjustment

If the accuracy of the 10 MHz oscillator is outside the specified range

for the product, the device is out of calibration. A programmable voltage
controls the oscillator frequency. By varying this voltage and precisely
measuring the frequency, you can find a voltage that gives a frequency as

close as possible to 10 MHz.

1. Complete steps a—c to set the oscillator control voltage. The range of
acceptable voltage values is 0.0 V to 4.095 V with frequency
increasing as voltage increases. Use a control voltage of 2.0475 V,
which is in the middle of the valid range, as a starting point.

a. Call niSync Initialize VI to set up a handle for the device.

LabVIEW Block Diagram

NI-SYNC C Function Call

esource name [ instiurnent handle oul

. - error out
rezet device

E..... |

Call niSync_init with the following
parameters:

resourceName: Devl
idQuery: NULL
resetDevice: VI_FALSE
vi: ¥*SessionHandle

b. Set a writable NI-Sync property node to pass the constant 2.0475
to the Oscillator Voltage attribute.

LabVIEW Block Diagram NI-SYNC C Function Call
Call niSync_SetAttributeViBoolean
eference in P — with the following parameters:
= S dl
vi: “<SessionHandle> "
Froperty Mode _J— t inalN cwn
m‘ - E = niSyns E erminaliName:
Tair i - attributelD:
NISYNC_ATTR_OSCILLATOR_VOLTAGE
2.0475 ] attributeValue: 2.0475
[Calibration Properties: Ozcillatar Valtage]

NI PXI-665x Calibration Procedure
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c. Call niSync Close VI to close the session handle.

LabVIEW Block Diagram NI-SYNC C Function Call

Call niSync_close with the following
inztrument handle in parameter:

vi: “<SessionHandle>~

Sa : i |emor out
lerror in [no error bolpEas ]

Proceed with the following steps to find the correct oscillator control
voltage.

2. After setting the control voltage, measure the frequency again with
the NI-Sync Measure Frequency VI to measure PFI 0, as shown in
step 3 of the Measuring the Frequency section. To obtain an accurate
measurement for calibration, the measurement duration must be made
sufficiently long. Refer to Table 1, Measurement Duration, for the
measurement duration to use.

Complete steps a—c to measure PFI 0.

a. Call niSync Initialize VI to set up a handle for the device.

LabVIEW Block Diagram NI-SYNC C Function Call
Call niSync_init with the following
Iesource name [ _ inztrument handle oub parameters:
[abs Ht Initialize. vi

resourceName: Devl

idQuery: NULL
_ | Query: N0
ez resetDevice: VI_FALSE
vi: *SessionHandle
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b. Call niSync Measure Frequency VI to measure the frequency of

the oscillator.

LabVIEW Block Diagram

NI-SYNC C Function Call

B

instrument handley

.5

ermor in

(I e

=

niSync Measure Frequency. wi

instrument bandle out

meazured fraquenc

Call niSync_MeasureFrequency with
the following parameters:

vi: “<SessionHandle>~
sourceTerminal:
NISYNC_VAL_OSCILLATOR
duration: 0.5 or 100
actualDuration: *actualDuration
measuredFrequency:
*measuredFrequency

error: *error

c. Call niSync Close VI to close the session handle.

LabVIEW Block Diagram

NI-SYNC C Function Call

itiztrument handle iny

/0 :l

ermor in [no eror

|
]

Call nisync_close with the following
parameter:

vi: “<SessionHandle> "~

Compare the measured frequency to the device specifications.

If the measured frequency is still outside of the specified limit, repeat
steps 1-3 of the Adjustment section until the measured value falls
within the acceptable frequency range for your module, as shown in
Table 4, Calibration Target Frequency Ranges.

Commit the calibration values to the Calibration EEPROM using

the following procedure.

a. Call niSync Initialize External Calibration VI to initialize the

process.

@ Note NI is the default user password. If you have changed the calibration password, use
your user-selected calibration password in place of NI.

NI PXI-665x Calibration Procedure

12

ni.com



LabVIEW Block Diagram

NI-SYNC C Function Call

hiSync Initialize Extemal Calibration. vi]

reS0UICE Name

[abck

:
Erommmmn =

instrument handle oot

Call niSync_InitExtCal with the
following parameters:

resourceName: “<MAX ID>"
password: NT
calibrationInstrumentHandle:
*SessionHandle

b. Call niSync Adjust Oscillator Voltage VI to adjust the voltage of

the oscillator.

LabVIEW Block Diagram

NI-SYNC C Function Call

instrument handle iy

instrument handle oot

new voltage

2.0475
o i i :
(S b B boan]

Call
niSync_CalAdjustOscillatorVoltage
with the following parameters:

vi: “<SessionHandle> "
new Voltage: <new control voltage>
oldVoltage: *oldvoltage

c. Call niSync Close External Calibration VI to commit the settings
and close the session.

LabVIEW Block Diagram

NI-SYNC C Function Call

instrument handle in) [5, s Closs Esternal Calibration, v
HI-ZTHG

Call niSync_CloseExtCal with the
following parameter:

vi: “<SessionHandle> "~
action: NISYNC_VAL_EXT CAL_COMMIT

Reverification

After completing the adjustments to the NI PXI-665x, it is important that
you verify the oscillator frequency operation by repeating the steps listed
in the Verification section. Re-verifying after making the adjustments
ensures that the NI PXI-665x is operating within its test limits.

© National Instruments Corporation 13
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Where to Go for Support

The National Instruments Web site is your complete resource for technical
support. At ni.com/support you have access to everything from
troubleshooting and application development self-help resources to email
and phone assistance from NI Application Engineers.

National Instruments corporate headquarters is located at

11500 North Mopac Expressway, Austin, Texas, 78759-3504.

National Instruments also has offices located around the world to help
address your support needs. For telephone support in the United States,
create your service request at ni . com/support and follow the calling
instructions or dial 512 795 8248. For telephone support outside the United
States, contact your local branch office:

Australia 1800 300 800, Austria 43 662 457990-0,

Belgium 32 (0) 2 757 0020, Brazil 55 11 3262 3599,

Canada 800 433 3488, China 86 21 5050 9800,

Czech Republic 420 224 235 774, Denmark 45 45 76 26 00,
Finland 358 (0) 9 725 72511, France 01 57 66 24 24,

Germany 49 89 7413130, India 91 80 41190000, Israel 972 3 6393737,
Ttaly 39 02 41309277, Japan 0120-527196, Korea 82 02 3451 3400,
Lebanon 961 (0) 1 33 28 28, Malaysia 1800 887710,

Mexico 01 800 010 0793, Netherlands 31 (0) 348 433 466,

New Zealand 0800 553 322, Norway 47 (0) 66 90 76 60,

Poland 48 22 328 90 10, Portugal 351 210 311 210,

Russia 7 495 783 6851, Singapore 1800 226 5886,

Slovenia 386 3 425 42 00, South Africa27 0 11 805 8197,

Spain 34 91 640 0085, Sweden 46 (0) 8 587 895 00,

Switzerland 41 56 2005151, Taiwan 886 02 2377 2222,

Thailand 662 278 6777, Turkey 90 212 279 3031,

United Kingdom 44 (0) 1635 523545

CVI, National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments
Corporation. Refer to the Terms of Use section on ni . com/1egal for more information about
National Instruments trademarks. The mark LabWindows is used under a license from Microsoft
Corporation. Windows is a registered trademark of Microsoft Corporation in the United States and
other countries. Other product and company names mentioned herein are trademarks or trade names
of their respective companies. For patents covering National Instruments products/technology, refer to
the appropriate location: Help»Patents in your software, the patents . txt file on your media, or the
National Instruments Patent Notice at ni . com/patents.
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